SiteLink Image Manager 4.2.0
User Guide
Manufactured
FUJIFILM Sonosite, Inc.
21919 30th Drive SE
Bothell, WA 98021
USA
T: 1-888-482-9449 or 1-425-951-1200
F: 1-425-951-1201

EC Authorized Representative
FUJIFILM Sonosite B.V.
Joop Geesinkweg 140
1114 AB Amsterdam,
The Netherlands

Australia Sponsor
FUJIFILM Sonosite
Australasia Pty Ltd
114 Old Pittwater Road
BROOKVALE, NSW, 2100
Australia

Caution: Federal (United States) law restricts this device to sale by or on the order of a physician.

Edge, M-Turbo, S Series, SiteLink, SonoCalc, Sonosite, and the SonoSite logo are trademarks or registered trademarks of FUJIFILM Sonosite, Inc. in various jurisdictions. FUJIFILM is a registered trademark of FUJIFILM Corporation. Value from Innovation is a trademark of FUJIFILM Holdings America Corporation.

All other trademarks are the property of their respective owners.


P08167-09 9/2018
Copyright © 2018 FUJIFILM Sonosite, Inc. All rights reserved.
Chapter 1: Introducing SiteLink Image Manager

Process overview ................................................................. 1-1
Software intended use ............................................................. 1-1
Safety .................................................................................. 1-3

Chapter 2: Installing and Configuring SiteLink

Installing software ............................................................... 2-5
Setting up hardware .............................................................. 2-5
Configuring the ultrasound system ....................................... 2-6
Configuring SiteLink ............................................................. 2-9

Chapter 3: Using SiteLink

Connecting to the network .................................................... 3-13
Starting and exiting SiteLink .................................................. 3-14
Archiving exams ................................................................. 3-14
Managing archiving ............................................................. 3-16
Viewing files on the PC ......................................................... 3-16
Moving files on the PC .......................................................... 3-17

Chapter 4: Troubleshooting

Symptoms and solutions ....................................................... 4-19
Checking SiteLink and system version ................................... 4-20
Technical Support contact information ................................... 4-20
Chapter 1: Introducing SiteLink Image Manager

FUJIFILM SonoSite SiteLink Image Manager 4.2.0 (SiteLink) transfers images and clips from the SonoSite Edge, SonoSite M-Turbo, M-OB/GYN Office, or SonoSite S Series ultrasound systems to a personal computer (PC). SiteLink also creates the following reports from your ultrasound system:

- Summary reports for cardiac, IMT, and vascular calculations
- EMED worksheets
- OB and GYN reports
- Carticept Navigator reports (in HTML format only)

See the ultrasound system user guide for information about the ultrasound system and transducers. See the FUJIFILM SonoSite accessory user guides for information about accessories.

Process overview

<table>
<thead>
<tr>
<th>Step</th>
<th>Refer to this document</th>
</tr>
</thead>
<tbody>
<tr>
<td>1a</td>
<td>Setting Up a Network Connection User Guide. or 1b The “Preparing the system” section of your ultrasound system user guide.</td>
</tr>
<tr>
<td>1b</td>
<td>Setting Up a Network Connection User Guide. or 1b The “Preparing the system” section of your ultrasound system user guide.</td>
</tr>
<tr>
<td>2a</td>
<td>“Configuring the ultrasound system” on page 6.</td>
</tr>
</tbody>
</table>

Software intended use

The ultrasound system lets you transfer images that are in JPEG or BMP file format. (By default, the ultrasound system uses JPEG file format.) These standard image files may be viewed using a variety of image-viewing software. The files can be printed or e-mailed.
Video clip files are formatted by default as H.264 video and saved as MP4 files. These files can be played in media players such as QuickTime.

**Caution:** Healthcare providers who maintain or transmit health information are required by the Health Insurance Portability and Accountability Act (HIPAA) of 1996 and the European Union Data Protection Directive (95/46/EC) to implement appropriate procedures: to ensure the integrity and confidentiality of information; to protect against any reasonably anticipated threats or hazards to the security or integrity of the information or unauthorized uses or disclosures of the information.

The system provides settings that let you meet the applicable security requirements listed in the HIPAA standard. SiteLink users are ultimately responsible for ensuring the security and protection of all electronic protected health information collected, saved, reviewed, and transmitted on the ultrasound system.

*Note:* To protect patient confidentiality, encrypt all patient images, files, or records before sending electronically.
Safety

The following safety information applies to the software product, accessory cables, and your PC.

A WARNING describes precautions necessary to prevent injury or loss of life.

A Caution describes precautions necessary to protect the products.

For labeling symbols used with FUJIFILM SonoSite products, see the ultrasound system user guide.

Electrical safety

| WARNING: | Connection to peripherals using a cable not recommended by FUJIFILM SonoSite could result in electrical shock. Avoid electrical shock hazards by using an accessory cable recommended by FUJIFILM SonoSite. Contact FUJIFILM SonoSite or your local representative for the accessory cable available from or recommended by FUJIFILM SonoSite. To avoid the risk of electrical shock, the electrical connection of a personal computer to the ultrasound system must be in a manner that complies with Table BBB.201 of IEC 60601-1-1:2001. |

Equipment protection

<table>
<thead>
<tr>
<th>Caution:</th>
<th>To protect your accessory cable, follow these precautions:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Excessive bending or twisting of cables can cause a failure or intermittent operation.</td>
<td></td>
</tr>
<tr>
<td>• Do not submerge the cable in solution. The cable is not liquid-tight.</td>
<td></td>
</tr>
<tr>
<td>• Do not use solvents such as thinner or benzene, or abrasive cleaners on any part of the cable.</td>
<td></td>
</tr>
<tr>
<td>• Do not spill liquid on the cable.</td>
<td></td>
</tr>
</tbody>
</table>

Clinical safety

| WARNING: | To avoid misdiagnosis, do not use the system if it exhibits artifacts on the LCD screen or PC monitor, either within or outside the clinical image. Artifacts are indicative of hardware and/or software errors that must be corrected before use. |
Chapter 2: Installing and Configuring SiteLink

To prepare SiteLink for use, you must install the software, set up the hardware, configure the ultrasound system, and configure SiteLink. You can designate up to five ultrasound systems for archiving exams.

**Caution:** When configuring SiteLink to work with your computer, ensure that your ultrasound system and computer share the same language. Otherwise, you may see broken image links in the resulting HTML reports.

**Installing software**

1. Log on to the PC as system administrator.
2. Insert the SiteLink disc into the CD-ROM drive.
3. Follow the on-screen instructions in the Install Shield installation wizard. In Windows 7 or Windows 8, when the User Account Control dialog box appears, click *Allow*.

   The installation process begins automatically. The files are placed by default into the following folder:

   `C:\Program Files\SonoSite\SiteLink Image Manager 4.2.0`

**Setting up hardware**

**To connect power**

1. (M-Turbo or M-OB/GYN Office only) Attach the ultrasound system to the mini-dock or docking system.
2. Ensure that AC power is connected.

   The DC power cable connects to the DC input connector located as follows:

   - (M-Turbo or M-OB/GYN Office) Mini-dock or docking system
   - (Edge or S Series) Back of system

   The AC power cord connects to a hospital-grade electrical outlet.

   See the FUJIFILM SonoSite accessory user guides for additional information.

**Connecting the ultrasound system to the PC**

If you don’t use a Local Area Network (LAN) or have access to wireless, then you must connect your ultrasound system to the PC.
To connect the ultrasound system to the PC

1 Connect the Ethernet crossover cable to the PC and to the Ethernet connector located as follows:
   - (M-Turbo or M-OB/GYN Office) Mini-dock or docking system
   - (Edge or S Series) Back of system
2 Turn on the ultrasound system.
   See your network administrator if connecting to a LAN.

Configuring the ultrasound system

The system’s SiteLink setup typically is completed by network administrators.

To set the transfer mode

❖ On the Connectivity setup page, select SiteLink from the Transfer Mode list.
   A dialog box prompts you to restart the system.

To configure SiteLink locations

1 Ensure that the transfer mode is set to SiteLink. See “To set the transfer mode.”
2 On the Connectivity setup page, select SiteLink Setup.
   Select New and fill in the following fields:
   Host Name Unique network name for the ultrasound system.
   Alias Name used to identify the network location of the ultrasound system.
   Network Select a network type.
   FIPS Select to activate.

Notes:
   • You must have a Wireless and Security Module installed to use FIPS. Refer to Setting Up a Wireless Network.
   • FIPS is not available with LAN.
   • Selecting FIPS restricts the available Security Policy choice on the next page to WPA2, the Encryption to AES, and the Authentication Type to EAP-TLS. All Profiles associated with a Location must have a WPA2 Security Policy, an AES Encryption, and an EAP-TLS Authentication Type before the FIPS option is enabled.
**Image Format** Select JPEG or BMP.

**JPEG Compression** Select a setting (High, Medium, or Low) if JPEG is selected for Image Format. A high compression has a smaller file size but less detail. See the ultrasound system user guide for information about the limitations of JPEG format.

**IP Address** Unique identifier of the ultrasound system location. Cannot be between 127.0.0.0 and 127.0.0.8. Must be the same as in the TCP/IP Socket Configuration dialog box in SiteLink. For a wireless location, enter a unique address using numbers from the first three fields of the router IP address and creating a unique number in the last field to identify this ultrasound system in the wireless network.

**Subnet Mask** Identifies a network subdivision. The default value is 255.255.0.0.

**Default Gateway** (Optional) IP address where network connects to another network. Cannot be between 127.0.0.0 and 127.0.0.8.

**Alternate Gateway** (Optional) Alternate location where network connects to another network. Cannot be between 127.0.0.0 and 127.0.0.8.

**Network Speed** (Ethernet Only) Select Auto or 100BT Full. If you use a 10BaseT network, select 100BT Full and use a 100BaseT hub between the ultrasound system and the network.

*Note: Do not select 10BT Full or 10BT Half. These settings cause system instability.*

3 (Wireless Only) Select Next to display page 2. Fill in the following fields:

**Profile Name** Name of profile set for this location. For each wireless location, you can have up to 10 profiles.

**Network Name SSID** Network Name Service Set Identifier for the router. (Use the same unique, case-sensitive name used in the Wireless Network Name (SSID) field in configuring the router.)

**Security Policy** Security type that authenticates the network:

- **OPEN** No security
- **WEP** or **SHARED WEP** Wired Equivalent Privacy security protocol. The following fields appear:
  - **Encryption** Encryption key type (64 bit or 128 bit).
  - **Key Index** WEP key index 1-4. Network location where a specific key is stored.
  - **Key** WEP key value used to encrypt data.
- **RADIUS** Remote Access Dial-Up User Service - 802.1x Key Exchange.
- **WPA** or **WPA2** Wi-Fi Protected Access-Enterprise. The following fields appear:
  - **WPA Authentication** Verifies network users through an authentication server. If you select PSK, the WPA PSK field appears; enter the WPA PSK used in configuring the router. (WPA PSK allows use of manually entered keys or passwords.)
  - **Encryption** Encryption protocol for the router.
4  (Wireless Only) If you selected RADIUS for Security Policy or for WPA Authentication, select Next and fill in the fields on page 3.

**Authentication Type** Select one of the following:

- **EAP-TLS** Extensible Authentication Protocol-Transport Layer Security. The following additional fields appear:
  - **Client Certificate** Certificate installed on system that allows network access to users with that certificate only.
  - **Private Key** One of a pair of keys (public and private) that is provided only to the requestor and never shared.
  - **Private Key Password** A unique combination of letters and/or symbols that allows user access.

- **EAP-PEAPv0** The following additional fields appear:
  - **Authentication** Process verifying identity of wireless device or end user to allow access to the network. This field is automatically set to EAP-MSCHAPV2.
  - **Password** A unique combination of letters and/or symbols that allows user access.
  - **Username** Name of designated user.
  - **Certification Authority** User must be logged in with the same username that was used when the client certificate was installed.
    
    For EAP-TLS, issuer of client certificate as recognized by the authentication server.
    
    For EAP-PEAPV0, a trusted third party that guarantees the user’s identity.

5  Select **Save**, and then select **Done** on-screen.

A dialog box prompts you to restart the system.

**Note** In order for the Wireless and Security Module to work with a specific location, you must restart the system with the location selected and the module already installed.

**To delete a location**

1  On the Connectivity setup page, select **SiteLink Setup**.
2  Select the location name from the list of locations.
3  Select **Delete**.
4  Select **Yes** to confirm deletion.
5 Select Done.

![SiteLink setup (M-Turbo shown)](image)

**Figure 2.1 SiteLink setup (M-Turbo shown)**

**Configuring SiteLink**

To configure SiteLink, you must specify the folder in which to save files and must specify TCP/IP connectivity.

The default folder for saving image and clip files is C:\SonoSite\. You can change this folder.

By default, SiteLink saves patient data in folders identified by patient name (according to the patient information form filled out on the ultrasound system). You can set SiteLink to save patient data in folders identified by ultrasound system user name instead. For instructions to create a patient information form, see the ultrasound system user guide.

**To specify the location of folders**

1. In SiteLink, select **Image Files Location** from the **Configure** menu, or click **Image Files Location** in the destination area.

2. Under **Browse Path**, select the desired folder.

   *Note: C:\Program Files\ and C:\Windows\ are administrative locations and unavailable. If you try to select one, SiteLink prompts you to select a different folder.*

3. If you want to save patient data in folders identified by ultrasound system user, click **Group Patients By User**.

   If you select this option, make sure that you fill in the **User** field in the patient information form on the ultrasound system. See the ultrasound system user guide for instructions.
4 Click **Save**.

5 Click **Yes** to accept.

![Select folder in which to save files](image)

**Figure 2.2 Select folder in which to save files**

**To specify TCP/IP connectivity**

Up to five systems can use SiteLink at once.

1 In SiteLink, select **Use TCP/IP Port** from the **Configure** menu.

2 Enter the IP address:
   - If connecting to TCP/IP through a network, enter the IP address in the dialog box. Each IP address (in standard IP format) must match the IP address entered in the Locations setup on the ultrasound system. (See “Configuring the ultrasound system” on page 6.)
   - If connecting to TCP/IP using the crossover cable, determine the IP address that the PC can connect to on the ultrasound system. Enter that IP address both into the dialog box and into the Locations setup on the ultrasound system. (See “Configuring the ultrasound system” on page 6.) See your network administrator if necessary.
3 Click **OK**.

![TCP/IP Socket Configuration dialog box](image)

**Figure 2.3** TCP/IP Socket Configuration dialog box
Chapter 3: Using SiteLink

Images and clips are archived from the ultrasound system to a PC using an Ethernet connection. Five ultrasound systems can be connected at a time.

Once SiteLink is properly configured, closed exams archive automatically after you connect to the network and start SiteLink.

Figure 3.1 SiteLink Image Manager

Connecting to the network

To connect to the network, you need to select your location.

To select a location

1 On the ultrasound system, make sure that the transfer mode is set to SiteLink. (See “To set the transfer mode” on page 6.)

2 On the Connectivity setup page, select a location from the Location list.
   A dialog box prompts you to restart the system.

See also “To configure SiteLink locations” on page 6.
Starting and exiting SiteLink

WARNING: To prevent loss of patient images or mixing of patient images, always enter the correct patient name and unique ID into the ultrasound system, and verify that the system date and time are correct.

When starting, SiteLink tries to establish a connection between the PC and ultrasound system. If an ultrasound system is not connected, SiteLink continually checks for a connection.

To start SiteLink

 Double-click the SiteLink Image Manager 4.2.0 shortcut. In Windows 8, SiteLink appears as a tile on the desktop.

To exit SiteLink

 In SiteLink, select Exit from the File menu.

Note: If you use SiteLink frequently, FUJIFILM SonoSite recommends minimizing the application and keeping it running instead of exiting.

Connection Status Icons in SiteLink

<table>
<thead>
<tr>
<th>Icon</th>
<th>Definition</th>
<th>Icon</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>Checking ultrasound connection</td>
<td><img src="image2.png" alt="Icon" /></td>
<td>Ultrasound system connected. Images archiving.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>Ultrasound connection established</td>
<td><img src="image4.png" alt="Icon" /></td>
<td>Suspended</td>
</tr>
</tbody>
</table>

Archiving exams

WARNING: To prevent loss of patient images or mixing of patient images, always enter the correct patient name and unique ID into the ultrasound system, and verify that the system date and time are correct.

SiteLink automatically archives patient exams when you close them. If the ultrasound system is not connected, SiteLink automatically archives closed exams when a connection is established.

After archiving an exam, SiteLink begins to archive the next one. After exams are transferred from the system, SiteLink proceeds to the next system listed in the TCP/IP Socket Configuration dialog box (See “Configuring SiteLink” on page 9). You can also manually rearchive exams in SiteLink, and you can manually delete images and clips from the ultrasound system.
If SiteLink is interrupted while archiving an exam’s images and clips, SiteLink automatically deletes the incomplete set of images and clips on the PC. The patient name folder remains; however, that particular exam is removed from the PC. The images and clips on the ultrasound system are not automatically deleted.

Images and clips are archived to the PC but cannot be returned to the ultrasound system.

To automatically archive exams
1. Start SiteLink.
2. Verify that the ultrasound system is turned on and that hardware is connected.
3. Verify that the connection icon is present on the ultrasound system.

Any saved, unarchived exams that are closed automatically begin archiving. Once the exam is archived, an archive-confirmed check mark appears in the last column in the patient list.

To stop archiving exams
—if you need to stop the connection during transfer, click the Disconnect button.
Click Reconnect to reinstate communication.

To manually rearchive exams
1. Start SiteLink.
2. Verify that the ultrasound system is turned on and that hardware is connected.
3. Verify that the connection icon is present on the ultrasound system.
4. On the ultrasound system, do one of the following:
   • For Edge, M-Turbo, or M-OB/GYN Office, press the REVIEW key.
   • For S Series, press Review.
5. If there is a current patient, select List.
6. Select the exams whose images and clips you want to archive.
7. Select Archive. Any archive-confirmed check marks are removed.

Once the exam is archived, an archive-confirmed check mark appears in the last column in the patient list. For more information, see the ultrasound system user guide.

Managing archiving
The patient list lets you manage archiving. Only complete exams (not individual images and clips) may be selected for archiving. For more information on the patient list, see the ultrasound system user guide.

![Patient List](image)

**Figure 3.2 Patient list (M-Turbo shown)**

### Viewing files on the PC

SiteLink saves image and clip files into a hierarchy of patient and exam folders using the following information: Patient Name and Patient ID, Exam Date, and Time of Image Save. SiteLink automatically generates numbers to uniquely identify the exam date and file name.

You can save files in folders grouped by User name instead of by Patient name. See "Configuring SiteLink" on page 9.

**To view the folder of saved files**

1. Double-click **My Computer** icon on the desktop.
2. Click **Local Disk (C:)** and then click the folder where files are saved (Sonosite by default).

**To view a report**

*Note: Patient images in PDF should not be used for diagnostic purposes. Important subtle details may be lost or invisible.*

1. Double-click **My Computer** icon on the desktop.
2. Click **Local Disk (C:)**, and then click **Sonosite**.
3. Select the desired patient and exam folder.
4 Open **PT_REPORT.HTML** or **PT_REPORT.PDF** to view the patient report.

To open the report, double-click it or drag it to an open Internet Explorer window (for HTML) or Adobe Reader (for PDF) window.

*Note: If your ultrasound system and computer don’t share the same language, you may see broken image links in the resulting report.*

### Moving files on the PC

If you need to move files (for example, from your C Drive to your D Drive), be certain you move the entire Study folder for that patient. The Study folder contains image files (for example, 07.03.25hrs_{0004726}.bmp), patient demographics files (for example, PT_PPS.XML), clip metadata files (for example, C0004726.XML), and report files (for example, REPORT.XML). Do not remove from the folder, copy, or modify any of these files. When using SiteLink to download SonoCalc IMT images, you must keep the data and report files associated with image files together.

**WARNING:** To avoid loss of patient information, use extreme care when moving patient images once they are transferred to your PC. Improperly moving image files may cause errors in SonoCalc IMT operations. If you must move individual patient images once they are transferred, follow the “To move files” procedure below.

**To move files**

1. Select the Patient folder.
2. Open the Study folder with the appropriate study number and view the existing files.
3. Close the Study folder.
4. Copy the Study folder to the new location.
5. Open the Study folder and verify that all files transferred.
6. Return to the old file location and delete the original Study folder.
Chapter 4: Troubleshooting

If you encounter difficulty with the system, try to troubleshoot the problem. See “Symptoms and solutions.” If the problem continues, contact FUJIFILM SonoSite Technical Support. (See “Technical Support contact information” on page 20.)

Symptoms and solutions

Table 1: Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection not established.</td>
<td>Verify that the ultrasound system is turned on. For M-Turbo or M-OB/GYN Office, verify that the ultrasound system is properly installed in the mini-dock or docking system and that the mini-dock or docking system has AC power. If connecting over a LAN, verify that both the PC and ultrasound system are connected to the network. If connecting the PC to the ultrasound system directly, verify that the Ethernet crossover cable is connected correctly. (See “Setting up hardware” on page 5.) Verify that SiteLink is configured with the correct IP address(es). Verify that both Sitelink and the ultrasound system are running. Verify that the ultrasound system is configured for SiteLink transfer and that the correct location is selected.</td>
</tr>
<tr>
<td>SiteLink does not transfer exams from the ultrasound system.</td>
<td>Verify that the PC and ultrasound system are running and connected. Determine if exams have already transferred, identified by an archive-confirmed check mark in the patient list on the ultrasound system. If you want to rearchive, manually select those exams and select Archive.</td>
</tr>
<tr>
<td>A timeout message appears on the status bar, and SiteLink resets to its initial state.</td>
<td>If connected to a LAN, verify that both the PC and ultrasound system are still connected to the network. If connecting directly to a PC, verify that the Ethernet crossover cable is connected. See your network administrator for a connection that is refused or slow.</td>
</tr>
</tbody>
</table>
Checking SiteLink and system version

In SiteLink, you can check the software version of SiteLink and the ultrasound system.

To check the version of SiteLink

 IDF  From the Help menu, select About SiteLink Image Manager.

To check the version of the ultrasound system

  1 Verify that the ultrasound system is connected.
  2 From the Help menu, select About the Ultrasound System.

Technical Support contact information

| Phone (US): | 877-657-8118 |
| Phone (Outside US): | 425-951-1330 (or contact your local representative) |
| Fax: | 425-951-6700 |
| E-mail: | service@sonosite.com |
| Web: | www.sonosite.com and click Support |